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1.1 About this Manual 

1.1.1 Scope 

The manual describes how the principle communication between ChromeleonTM and the 
connected modules is tested when Chromeleon is installed or upgraded. It is not intended 
to completely validate all communication functions. 

The document is not intended to describe a procedure for Operational or Performance 
Qualification of the connected modules. However, Operational or Performance 
Qualification of the connected modules can be performed instead of Instrument 
Installation Qualification. 

1.1.2 Overview 

The following table provides a quick overview to the chapters in the manual. 

Section  Content 

2 Introduction Describes the intention of the Installation Qualification, summarizes the 
supported devices and how to perform the qualification dependent on the 
installed system. 

3 Requirements and 
Preparations 

• Required parts 

• Preparation steps 

4 Performing Automated 
HPLC IQ in Chromeleon 

Describes how to prepare and perform the standard AutoQ™ checks. Since 
the procedures depend on the Chromeleon version, the procedures are 
described in two separate sections. Follow the instructions in this section in 
the given order. Descriptions for the Chromeleon version not used for the 
qualification can be skipped. 

5 HPLC Systems – Test 
Design and Hints for 
Manual Test Execution 

Describes the test design, expected measuring results, and how to test 
devices manually if no AutoQ test sequences are available for that device. 
Descriptions for modules that are not installed in the system can be skipped. 

6 GC Systems Describes how to test GC systems manually. Descriptions for modules that 
are not installed in the system can be skipped. 

7 Appendix Contains a filled in example form IQ_Report_Comm_Test.docx. 

 

TIP We recommend that you read the manual thoroughly before starting Chromeleon 
Installation Qualification (AutoQ routines) in order to obtain full understanding of the 
procedure. 
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1.2 Conventions 
This section describes the conventions that are used throughout this manual. 

1.2.1 Terminology 

The descriptions in all sections except section 4.2, page 35 use the terminology used in 
Chromeleon 6.80. 

TIP In Chromeleon 7, the terminology differs from that in Chromeleon 6. For detailed 
information, refer to Glossary – Chromeleon 7.x included in the Documents folder of the 
Chromeleon 7 Installation. 

All descriptions in this manual referring to Corona™ detectors equally apply to charged 
aerosol detectors. 

1.2.2 Special Notices and Informational Notes 

Special notices and informational notes in this manual appear different from the main 
flow of text. They appear in boxes and a note label identifies them. The label text appears 
in uppercase letters and in bold type. 

NOTICE Highlights information necessary to prevent invalid test results and ensure a 
problem-free installation. 

 

TIP Highlights information of general interest or helpful information that can make a task 
easier or optimize the performance of the equipment. 

 

1.2.3 Typographical Conventions 

These typographical conventions apply to the descriptions in this manual: 
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Notation Description 

Bold Data input and output: 

• Input that you enter by the keyboard or that you select with the mouse 

• Buttons that you click on the screen 

• Commands that you enter by the keyboard 

• Names of, for example, dialog boxes, properties, and parameters 

• Paths: 
For brevity, long expressions and paths appear in the condensed form, for example: 
Click Start > All Programs > Thermo Chromeleon 7 > Service Manager > 
Start Instrument Controller. 

Italics • Particularly important words in the main flow of text 

• References to additional documentation 

"text" Messages that appear on the screen 

1.2.4 Other Conventions 

1.2.4.1 Viewpoint 
If not otherwise stated, the expressions left and right in this manual always refer to the 
viewpoint of a person that is facing the device from the front. 

1.2.4.2 Electronic Manual Version (PDF) 
The electronic version (PDF) of the manual contains numerous links that you can click to 
go to other locations within the manual. These include: 

• Table of contents entries 

• Index entries 

• Cross-references (in blue text), for example, to sections and figures 

1.2.4.3 Part Numbers 

For standards, solvents and columns, part numbers are Fisher catalog numbers. 
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2.1 Installation Qualification 
The HPLC instrument installation qualification is used to confirm that the principle 
communication between Chromeleon and the chromatography system corresponds to 
the expected behavior. 

Communication is tested by evaluating the quality of the recorded detector signals. In 
Chromeleon, different parameters that can be checked are set for the modules. The data 
is checked for precision and accuracy; the limits for checking are quite wide. In addition, 
the test shall demonstrate that the "start of sample - injection - data acquisition - end of 
data acquisition - end of sample - start of the next sample" cycle runs as planned. The 
runs are short; they last few minutes only. The following basic functions will be tested: 

• Module control in principle 

• Check of the chromatography system including loading or running a sample sequence 

• Qualitatively accurate data acquisition and evaluation 

• Indirect test of database access 

In addition, some functions and/or parameters are checked for each module by setting 
them on the control panel and comparing them to the values set on the module. 



2   •   Introduction 

HPLC Instrument Installation Qualification Revision: 5.7 dated July 2022  Page 13 

2.2 Supported Devices 
The standard AutoQ checks are optimized for the following Thermo Scientific HPLC 
devices:  

• Pumps 

• Autosamplers 

• Detectors 

• Fraction collectors 

For these devices, the qualification is performed automatically according to the 
descriptions in chapter 4, page 13 (for exceptions, see also section 2.3, page 13). 
Therefore, all manual checks described in chapter 5, page Fehler! Textmarke nicht 
definiert. and their documentation on the form IQ_Report_Comm_Test.docx can be 
omitted for the mentioned devices (Exception: For fraction collectors, see descriptions in 
chapter 5.12.2, page 63). 

The standard AutoQ checks not are optimized for the following devices:  

• Thermo Scientific HPLC column thermostats 

• Third-party HPLC devices and systems 

• Preparative HPLC devices and systems 

• GC devices and systems 

Depending on the device, either no checks are offered or warning or error messages can 
occur during batch ready check. If no checks are offered, the sequences and program files 
have to be created manually according to chapter 5, page Fehler! Textmarke nicht 
definiert.. If warning or error messages occur during batch ready check, the templates 
have to be adapted accordingly. 

2.3 Known Restrictions 
The standard AutoQ checks do not support systems with Vanquish mass spectrometry 
(MS) detector and fluorescence (FL) or Refractive Index (RI) detector. When using such a 
system, the AutoQ offers a check for the MS detector. To check the FL or RI detector, do 
the following: 

1. In the Chromeleon Server Configuration program, remove the MS detector from your 
instrument.  
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2. Install any Vanquish UV detector in simulation mode. 

3. Run the Installation Qualification Wizard for a second time. 

4. Select only the specific detector test for the FL or RI detector. 

5. When the message The instrument queue contains sequences that are not finished. 
Should the qualification be continued and the instrument queue be cleared? 
appears, select No. 

6. Add the specific detector test sequence to the queue manually. 

7. Add the MS detector to your instrument. 

8. Delete the UV detector from your instrument. 

9. Start the queue. 
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3.1 Software Requirement 
Data acquisition must be performed using Chromeleon. 

3.2 Analytical HPLC 
This section lists preparations for specific device types. If a module is not listed, no specific 
preparation steps are required. 

3.2.1 Dual Gradient Pumps 

3.2.1.1 Preparations 

Both pump units at one timebase – Tandem LC 

1. When performing Instruments IQ for a timebase that includes a dual gradient pump, 
verify that the left pump unit (device name: PumpLeft or LoadingPump) is fluidically 
connected to the autosampler, column, and detector. 

2. During the tests, only the left pump unit delivers the eluent. Set the flow rate for the 
right pump unit (device name: PumpRight or MicroPump) to 0°mL/min. 

TIP For Vanquish Tandem LC systems, both valves are switched to position 1_2 to match 
with the default Tandem LC configuration for column A. Verify that the fluidic connections 
match with this valve configuration. 

Pump units shared between two timebases – Dual LC 

If the pump units of a dual gradient pump are shared between two different systems (i.e. 
timebases), no specific preparations are required. 

3.2.2 Autosamplers 

3.2.2.1 Materials Required 

Autosampler Type Material Part Number 

UltiMate 3000  
WPS-3000(T)PL(RS) 

Upgrade Kit for the 250 µL syringe 

 

6820.0031 

WPS-3000TBPL Analytical and 
WPS-3000T(B)FC Analytical 

Standard configuration (sample loop volume: 50 µL) - 

UltiMate 3000 OAS-3600TXRS Well plate with 96 wells 6820.4100 
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3.2.2.2 Preparations 

Vanquish Dual Autosampler 

Because the sampler units of a dual autosampler are shared between two different 
systems (i.e. timebases), no specific preparations are required. 

WPS-3000(T)PL(RS) 

Install the Upgrade Kit for the 250 µL syringe. 
This kit also includes a sample loop (volume: 125 µL). If you want to use a different sample 
loop for the test, make sure that the sample loop has a minimum volume of 20 µL. 
Otherwise, the peak area deviation may exceed ± 5%. 

WPS-3000TBPL Analytical and WPS-3000T(B)FC Analytical 

1. Install the standard configuration (sample loop volume: 50 µL). 

2. Enable the following autosampler model on the Options tab page in the Chromeleon 
Server Configuration: 
♦ WPS-3000TBPL Analytical: WPS-3000TBPL Analytical 

♦ WPS-3000T(B)FC Analytical: WPS-3000TFC/WPS-3000TBFC 

UltiMate 3000 OAS-3600TXRS 

Fill the requested well with at least 350 µL of the sample according to the position and 
sample given in the following detector sections applicable for your system. 

3.2.3 Ultraviolet/Corona/Mass Spectrometry Detector 

For HPLC systems with at least one UV detector, a Corona and/or MS detector, a mixture 
of uracil and caffeine dissolved in water is injected and separated in a column. For 
UV/Corona and/or MS tests, different standard concentrations are used. All other 
chromatographic conditions are identical. 

3.2.3.1 Materials Required 

Material Description Part Number 

Standard Standard mixture of uracil (50 µg/g) and caffeine 
(60 µg/g) dissolved in water 

For UV/Corona tests, use the standard undiluted. 

For MS detector tests, dilute the standard as 
described in the section Producing the 
Standard(s), page 18. 

3321.0010A 

Column AcclaimTM 120, C18, 5 µm analytical 
(4.6 x 100 mm) or a similar column 

059147 
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Material Description Part Number 

Solvent Methanol (HPLC-grade) - 

 Water (HPLC-grade) - 

3.2.3.2 Preparations 

Preparations for the MS Detector 

Notice Acceptable results can only be obtained, if the detector is properly calibrated 
before (positive and negative polarity). Before starting the installation qualification, verify 
that the MS detector is ready for operation according to the instrument operating 
manual. 

 

Notice If a HESI / APCI dual source is used, ensure that the HESI probe is installed and the 
corona needle is in HESI position. 

 

TIP Ensure that the used pump is set correctly in the Associate pump info tab of the 
detector in the Chromeleon 7 Instrument Configuration Manager. For dual gradient 
pumps apply the left pump unit in the Associate pump info tab (the flow rate of the right 
pump unit is set automatically to 0 mL/min). 

Producing the Standard(s) 

TIP If no suitable pipette for the stated volumes is available, you can adapt the dilution 
steps to your laboratory equipment. 

For UV/Corona tests, use the standard stated above (part number 3321.0010A) to prepare 
an undiluted standard S1. For MS detector tests, prepare a diluted standard S2: 

1. Pipette the entire standard (part number 3321.0010A) in a vial S1. 

2. For instruments with MS detector only: Pipette 20 µL of S1 and 980 µL of water in a 
second vial, close the vial and shake it (sample solution (S2) – resulting concentration: 
uracil: 1 µg/g; caffeine: 1.2 µg/g). 

3. Close vial S1. 

Other Preparations 

1. Prepare the eluent mixture for channel A(1): Water/methanol (60/40 Vol.%) 

2. Put the sample(s) into the position as shown in the table below. 
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Autosampler Series Sampler Position for UV/Corona 
Detector (S1) 

Sampler Position for MS 
Detector (S2) 

Vanquish R:A1 R:A5 

UltiMate RA1 RA5 

Any other autosampler 1 5 

 

3. Connect the column between the autosampler and the (first) detector. 

4. Optionally, place the column in a column thermostat. 

5. Thoroughly rinse the HPLC system with eluent. 

3.2.4 Fluorescence Detector 

For HPLC systems including a fluorescence (FL) detector, pyrene dissolved in methanol is 
injected and separated in a column.  

3.2.4.1 Materials Required 

Material Description Part Number 

Standard Pyrene (solid) 

Due to legal shipping restrictions, the 
pyrene standard is shipped in solid form. 
Before you can use the standard, dissolve 
the solid pyrene in 1 mL of methanol as 
described in the following section. 

3327.0010 

Column Acclaim 120, C18, 5 µm analytical 
(4.6 x 100 mm) or a similar column 

059147 

Eluent Methanol (HPLC-grade) - 

3.2.4.2 Preparations 

Dissolving Solid Pyrene 

To dissolve the solid pyrene in 1 mL of methanol (HPLC-grade): 

1. Unscrew the cap from the 1.5 mL vial labeled 3 µg pyrene. 

2. Add about 1 mL of methanol (HPLC grade), which is about half of the vial's volume. 

3. Screw the cap onto the vial. Make sure that the cap seals tight. 

4. Shake the vial for about 10 seconds to dissolve the solid pyrene. 

5. Place the vial at the appropriate position in the autosampler. 
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Other Preparations 

1. Prepare the eluent for channel A(1): 100% methanol 

2. Put the sample into the position as shown in the table.  

Autosampler Series Sampler Position 

Vanquish R:A2 

UltiMate RA2 

Any autosampler 2 

 

3. Connect the column between the autosampler and the (first) detector. 

4. Optionally, place the column in a column thermostat. 

5. If your HPLC system includes an FL detector but no UV or Corona detector: Thoroughly 
rinse the HPLC system with eluent.  
If your system includes a UV or Corona detector, the eluent is changed and the HPLC 
system is rinsed automatically during qualification. 

3.2.5 Electrochemical Detector 

For HPLC systems including an electrochemical (EC) detector (for example, Thermo 
Scientific UltiMate 3000 ECD-3000RS), a catecholamine standard is injected and separated 
in a column. 

3.2.5.1 Materials Required 

TIP Several material may be available only via Fisher Scientific Shop. 
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Material Description Part Number 

Eluent MOBILE PHASE TEST 70-3829 Both materials are also 
available together under 
the part number 70-7655 

Standard Catecholamine standard, consisting of:  

• Norepinephrine 

• Epinephrine  

• Dopamine 

Concentration (stock solution): 1mg/mL 

Prepare the standard is described in the 
following section. 

45-0206 

Column Acclaim 120, C18, 5 µm analytical 
(4.6 x 100 mm) or a similar column 

059147 

3.2.5.2 Preparations 

Producing the Standard 

TIP If no suitable pipette for the stated volumes is available, you can adapt the dilution 
steps to your laboratory equipment. 

Use the above stated stock solution (S1) with a concentration of 1 mg/mL and produce a 
sample solution (P1) with a final concentration of 100 ng/mL that is used for the 
qualification: 

1. Pipette 5 µL of the stock solution S1 and 495 µL of the mobile phase in a vial, close the 
vial, and shake it (1st dilution – resulting concentration: 10,000 ng/mL = 10 µg/mL). 

2. Pipette 5 µL of the 1st dilution and 495 µL of the mobile phase in a vial, close the vial 
and shake it (sample solution (P1) – resulting concentration: 100 ng/mL) 

TIP At ambient temperature, the sample solution (P1) remains stable only for 12 hours. 

Other Preparations 

1. Prepare the eluent for channel A (1): 100% TEST mobile phase 

2. Put the sample into the position as shown in the table.  

Autosampler Series Sampler Position 

Vanquish R:A3 

UltiMate RA3 

Any other autosampler 3 

 

3. Connect the column between the autosampler and the (first) detector. 
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4. Optionally, place the column in a column thermostat. 

5. If your HPLC system includes an EC detector but no other detector:  
Thoroughly rinse the HPLC system with eluent.  
If your system includes any other detector, the eluent is changed and the HPLC 
system is rinsed automatically during qualification. 

3.2.6 Refractive Index Detector 

For HPLC systems inlcuding a refractive index (RI) detector, toluene dissolved in methanol 
is injected and separated in a column.  

3.2.6.1 Materials Required 

Material Description Part Number 

Standard Toluene dissolved in methanol (5 µL/mL) 

Producing the standard is described in the following 
section. 

For toluene: T290-1 

Column Acclaim 120, C18, 5 µm analytical (4.6 x 100 mm) or a 
similar column 

059147 

Eluent Methanol (HPLC-grade) - 

3.2.6.2 Preparations 

Producing the Standard 

TIP If no suitable pipette for the stated volumes is available, you can adapt the dilution 
steps to your laboratory equipment. 

Use toluene and methanol and produce the standard with a final concentration of 
5 µL/mL that is used for the qualification: 

1. Pipette 5 µL toluene and 995 µL methanol in a vial 

2. Close the vial. 

3. Shake it. 

Other Preparations 

1. Prepare the eluent channel A (1): 100% methanol. 

2. Put the sample into the position as shown in the table.  

3. Connect the column between the autosampler and the (first) detector 

4. Optionally, place the column in a column thermostat. 
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Autosampler Series Sampler Position 

Vanquish R:A4  

UltiMate RA4 

Any other autosampler 4 

 

5. If your HPLC system includes an RI detector but no UV or Corona detector: 
Thoroughly rinse the flow cell of the RI detector with eluent.  
If your system includes a UV or Corona detector, the eluent is changed and the flow 
cell of the detector is rinsed automatically during qualification. 

3.2.7 Evaporative Light Scattering Detector 
 

TIP Evaporative light scattering (ELS) detectors are not covered by the standard AutoQ 
checks. 

For HPLC systems including an ELS detector, glucose dissolved in water is injected.  

3.2.7.1 Materials Required 

• Glucose dissolved in water (0.125 mg/mL) 

• Restriction capillary to connect the autosampler to the detector 

• HPLC-grade water 

3.2.7.2 Preparations 
1. Prepare the eluent for channel A (1): 100% water. 

2. Put the sample into any free autosampler position.  

3. Connect the column between the autosampler and the (first) detector. 

4. Optionally, place the column in a column thermostat. 

3.2.8 Fraction Collector 

For HPLC systems inlcuding a fraction collector, solvent is collected in a 1.5 mL standard 
vial.  
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3.2.8.1 Materials Required 

Material Description Part Number 

Empty vial 1.5 mL vial with pre-split cap - 

Column Acclaim 120, C18, 5 µm analytical (4.6 x 100 mm) or a 
similar column or any restriction capillary (back pressure 
should be greater than 40 bar @ 0.6 mL/min flow rate) 

059147 

Eluent Methanol (HPLC-grade) 
Water (HPLC-grade) 

- 

3.2.8.2 Preparations 

Other Preparations 

1. Ensure that the needle pusher position is in vial. 

2. Select the 100 µm x 350 mm capillary in the Chromeleon Fraction Collector ePanel 
(More Options – Delay Volume – Delay Capillary IDxL). 

3. Place the empty vial in the Fraction Collector at R:A1, Vanquish 54 Vial Rack. 

4. Prepare the eluent mixture for channel A(1): As already used, e.g., water/methanol 
(60/40 Vol.%). 

5. Connect the column or restriction capillary between the autosampler and the (first) 
detector. 

6. Optionally, place the column in a column thermostat. 

7. Thoroughly rinse the HPLC system with eluent. 

3.2.9 System Equilibration 

Use an appropriate control panel to equilibrate the chromatography system. If applicable 
for your system, consider following: 

1. Turn on all modules in the system according to the operating instructions of the 
manufacturer.  

2. Allow all modules to warm up.  

3. Ensure that all modules are in operable state.  

4. Purge the pump, system and the column sufficiently with the eluent to be used. 

5. Apply the following basic chromatography conditions to the system and allow the 
system to equilibrate until the pressure, detector signal, and temperatures are stable: 
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♦ Flow rate: 0.6 mL/min 

♦ Column thermostat temperature: 25 °C 

♦ RI detector temperature: 35 °C 
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3.3 Preparative HPLC 

3.3.1 Materials Required 

3.3.1.1 Preparative HPLC Column 

One of the customer's columns. As these may be quite different, no sample mixture is 
used for separation.  

3.3.1.2 Standard for Reversed-Phase Chromatography 

A pure uracil sample dissolved in methanol (or another quickly retarding, polar substance 
which is available for the customer in sufficient quantity).  

3.3.1.3 Standard for Normal-Phase Chromatography 

An appropriate dead time marker,for example, toluene. 

If necessary, adapt the eluents and detector control parameters to the changed 
chromatographic conditions. 

3.3.2 Tips for Concentrations 

The modules of preparative HPLC systems are generally designed for higher 
concentrations. Therefore, adapt the concentration of the injected standard accordingly. 
The column has the greatest influence on defining a suitable concentration for the 
qualification. 

The separation capacity of the column is proportional to its cross-section. This fact also 
determines the concentration to be used for the injection. The concentration used for 
testing the analytical system gives you a clue. 

Example: 

Parameter Settings 

Concentration of uracil for a column diameter of 4.6 mm 40 mg/L 

Column diameter of the preparative column 30 mm  

Cross-section of the column A = π d² /4 

Cross-section of the analytical column 16.6 mm² 

Cross-section of the preparative column 706.8 mm² 
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Parameter Settings 

Preparative concentration (= ConcentrationAnalytical x  
Cross-sectionPreparative / Cross-sectionAnalytical) 

40 mg/L x (706.8 / 16.6) = 40 mg/L x 
42.6 ≈ 1600 mg/L 

3.3.3 Tips for Flow Rate 

Adapt the flow rate to the used components. The column has the greatest influence on 
defining a suitable flow rate, too. 

The retention time is almost proportional to the column volume. This fact also determines 
the flow rate to be used. The flow rate used for testing the analytical system gives you a 
clue. 

Example: 

Parameter Settings 

Flow for a column of 4.6 x 100 mm 0.6 mL/min 

Dimensions of the preparative column 30 x 250 mm (ID x l) 

Column volume V = lD²π/4 

Volume of the analytical column 1.66 mL 

Volume of the preparative column 176.7 mL 

Preparative flow (=FlowAnalytical x VolumePreparative / 
VolumeAnalytical) 

0.6 mL/min x (176.7 / 1.66) = 
0.6 mL/min x 106.4 ≈ 64 mL/min 

 

3.4 GC Systems 
The separation conditions for GC applications largely depend on the columns used. You 
have to prepare an appropriate test mixture and the separation method available. Make 
sure that the application completely separates the analyte from the solvent. 
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4.1 Chromeleon 6 

4.1.1 Installation Qualification Procedure 

Chromeleon offers standard AutoQ checks that cover tests for HPLC pumps, 
autosamplers, and various detector types. The checks are optimized for Thermo Scientific 
modules and are described in chapter 5, page Fehler! Textmarke nicht definiert.. For 
column thermostats or other chromatographic systems, the standard AutoQ checks are 
not available or optimized. In this case, the seqences and program files have to be created 
manually according to chapter 5, page Fehler! Textmarke nicht definiert. or they have to 
be adapted accordingly. 

A wizard guides you through the automated sequence creation. The sequences contain 
programs that contain all necessary commands. The programs are assigned automatically 
to the samples to process. 

The sequences are added manually to the batch list. The batch is started manually after 
the Ready Check has been performed. During sample processing, you can observe the 
acquired date and whether all functions are performed. The audit trail lists all program 
commands including execution times, feedback from the injector, and name of the 
sample. After the sequence has been processed, the processed samples are evaluated 
highly automated with a report linked to the sequence templates. 

The qualification for a system with pump, autosampler and one detector takes about 
1.5 hours. 

For more information about the test design, see chapter 5, page Fehler! Textmarke nicht 
definiert.. 

4.1.2 Template Directory Structure on the Chromeleon CD 

A data source named CM_CD is provided on the Chromeleon CD. The IQ directory in this 
data source has the following folder structure: 

Folder Name Description 

DEMO Including examples for HPLC and NANO_CAP_MIC_LC 
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Folder Name Description 

HPLC_Templates Contains the sequences for Installation Qualification in an analytical 
LC configuration (HPLC / UHPLC or GC). 

Note that the program files included in this folder do not provide 
any specific commands that may be required for control of third-
party modules. If, for this reason, any warnings or error messages 
occur during program execution, the templates have to be adapted 
accordingly. 

NANO_CAP_MIC_LC_Templates Contains the sequence for nano, cap, and micro LC systems. 

Reports When the sequences are copied from the CD, the report template is 
automatically copied to the corresponding directory. For 
information about the report structure, and how to adapt and sign 
reports, see section 4.1.6, page 33. 

Chromeleon selects the appropriate template for the installed timebase automatically. 

TIP All descriptions in this manual refer to the templates in the HPLC_Templates folder. 

4.1.3 Creating Sequence Templates 

To create the sequences required for your system, follow the steps: 

1. Insert the Chromeleon CD. Or else, verify that you can access the IQ directory. 

2. In the Chromeleon Browser, select Qualification > Instruments IQ…. 
A wizard guides you through the process of copying the sequences. Clicking Next> 
takes you to the next step in the procedure. 

3. Select the computer and the timebase for which you want to perform Installation 
Qualification.  

4. Select the source directory for the master sequences: Select IQ. 

5. Select the directory where all sequence templates should be saved (default directory: 
Standard datasource\Timebase\IQ_Runs\HPLC_Templates <Date>) 

 

TIP The standard datasource for a server is defined in the Server Configuration program. 
In this datasource, Chromeleon stores, for example, the daily audit trail. The standard 
datasource can be either a datasource or a directory in a datasource. In the directory of 
the standard datasource, Chromeleon automatically creates a subdirectory for each 
timebase. 

 

6. Enter a unique folder name. 



4   •   Performing Automated HPLC IQ in Chromeleon 

HPLC Instrument Installation Qualification Revision: 5.7 dated July 2022  Page 31 

7. A number of sequences is displayed, matching the selected timebase and can contain 
the following sequences (maximum one per block): 

Sequence / Order Necessary Device Property / Additional Requirement 

Block 1 

IQ_Pump(_xy) 

The IQ_Pump(_xy) sequence tests the flow rate for an analytical HPLC 
system. 

 IQ_Pump Pump.Flow and UV/Corona detector 

 IQ_Pump_RI Pump.Flow and RI detector, but no UV/Corona detector 

 IQ_Pump_FLD  Pump.Flow and FLD detector, but no UV/Corona/RI detector 

 IQ_Pump_ECD Pump.Flow and ECD detector, but no UV/Corona/RI/FLD detector 

Block 2 

IQ_Inject_Det(_xy) 

The IQ_Inject_Det(_xy) sequence tests the autosampler. Indirectly, this 
sequence also tests: 

• Corona detectors 

• RI detectors 

• Basic functions of Chromeleon 

 IQ_Inject_Det Inject and UV/Corona detector if the UV detector does not include a 
LightPipeTM flow cell 

 IQ_Inject_Det_RI Inject and RI detector, but no UV/Corona detector 

 IQ_Inject_Det_FL
D 

Inject and FLD detector, but no UV/Corona/RI detector 

 IQ_Inject_ECD Inject and ECD detector, but no UV/Corona/RI/FLD detector 

Block 3  

IQ_Inject_Det_CAD Inject and Corona detector if the UV detector includes a LightPipe flow 
cell 

Block 4  

IQ_UV_Det This sequence tests a UV detector with variable wavelength.  

Wavelength <UV_VIS_1>(1) 

Block 5  

IQ_Inject_Det_RI Inject and RI and UV or Corona detector 

Block 6  

IQ_FL_Det This sequence tests a fluorescence detector. 

Emission wavelength <Emission_1>(1) 

Block 7  

IQ_EC_Det This sequence tests an electrochemical detector. 

Potential <ECDRS_1>(1) 

(1) The device channel name (marked by angle brackets <>) can be selected freely and may deviate from the 
default value. The created sequences and their program files are adapted automatically to the used 
device and channel names. 

8. Select the sequence(s) to be added. 
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TIP For systems with a non-Chromeleon controlled detector, it is sufficient to run the test 
sequences IQ_Pump(_xy) and IQ_Inject_Det(_xy). 

 

9. Click Next. 
The report is opened. 

10. Make report adoptions as described in section 4.1.4, page 32. 

4.1.4 Adapting the Report 

4.1.4.1 General Information 
When the sequences are copied from the CD, the report template is automatically copied 
to the corresponding directory and linked as preferred report to all test sequence 
templates. The report template consists of the following seven pages: 

Page Name Description 

General This page specifies the devices, test information (see section below) and 
limits. The limits are listed in column H, starting with line 20. You only have 
to change these limits if you do not want to use the limits recommended by 
Thermo Fisher Scientific Inc. 

Results_Pump These pages are used for the evaluation of the respective module. 

Results_Inj_Det 

Results_UV 

Results_FL 

Results EC 

Audit Trail 

4.1.4.2 Adapting 

TIP The instrument parameters are read automatically only if the sequences have already 
been processed. If you open a report without samples, the values are not read 
automatically. 

Follow these steps 

1. To disable the write protection of the report, click Edit > Layout Mode. 

2. On General sheet, enter: 
a) Lot numbers 

b) Expiration dates 

c) Names of reviewer and operator 
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d) Serial numbers in lines O12-O18 (highlighted in light yellow): 
Typically, the serial numbers of the instruments are automatically entered into 
the report. If a serial number field shows "n.a.": Delete the value in the respective 
field so that the existing precond.xxx entry in the Status Line is deleted and enter 
the serial number into this field. 

e) Model types in lines L12-L18 (highlighted in light yellow): 
Typically, the model types of the instruments are automatically entered into the 
report. If a model type field shows "n.a.": Delete the value in the respective field 
so that the existing precond.xxx entry in the Status Line is deleted and enter the 
model type into this field. 

3. If applicable, save the modifications and close the report. 

4.1.5 Starting the Checks 
 

TIP The program files included in the HPLC Templates folder do not provide any specific 
commands that may be required to control third-party modules. If, for this reason, any 
warnings or error messages occur during program execution, the templates have to be 
adapted accordingly. 

 

1. If necessary, modify the created sequences (see sections 7.1 and 3.3). 

TIP When an autosampler with variable injection volume is tested, the different volumes 
are not set in the sequence. The programs are different for each sample. They use the 
following command:  
0.000 Inject Volume=20 

 

2. Add the installed checks to the batch list. The order of the checks must match the 
order of the list given in step 7, section 4.1.3, page 30.  

3. To start, click the Start button. 
For troubleshooting deviating measuring conditions and results, refer to section 7.1, 
page 72. 

4.1.6 Report Evaluation 
 

TIP Before evaluating and signing the results, check that all peaks were detected properly. 
Otherwise, adapt the peak windows (within the quantification method) accordingly. 

You can automatically evaluate the sequences, using the IQ_Report (Instruments_IQ_x_y) 
report template. If the measuring results are within the specified limits, the text in the 
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Results of Instrument… section of the respective Results page is Test passed. There are 
two possibilities to evaluate and sign the report: 

• Paper based 

• Electronic signature 

TIP To be able to sign a test sequence electronically, the user has to be registered in the 
Chromeleon user database and has to have the necessary signature privileges. If, for 
example, a Field Service Engineer has to sign electronically, he has to be added to the 
Chromeleon user database or a registered substitute has to sign the report. For detailed 
information about the electronic signature process, see also the Chromeleon Help. 

Paper based 

In the Browser, select File > Batch Report. 

By default, evaluation of the IQ_Pump(_xy) and IQ_Inject_Det(_xy) sequences is 
performed using the <UV_VIS_1> signal. If you want to evaluate a Corona detector, select 
the <CAD_1> channel in the dialog window of the Batch Report… function (see 
section 5.7.4, page 55). For all other sequences, it is not necessary to adapt the channel 
name.  

Electronic signature 

1. Select the sequence that you want to evaluate and sign electronically. 

2. Click File > Electronic Signature > Submit Results…. 

3. Select the channel to be used for evaluation: 

♦ UV detectors: <UV_VIS_1> 

♦ Corona detectors: <CAD_1> 

4. To start signing the results, click OK. 

5. Check the signed results and if the results are correct, click OK. 

6. Enter your signature password and optionally a comment. 

7. Click OK. 
The names and dates are automatically entered into the line Submitter / Operator. 

8. Optionally, repeat all steps above for Review Results… and / or Approve Results…. 
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4.2 Chromeleon 7 

4.2.1 Installation Qualification Procedure 

Chromeleon offers standard AutoQ tests that cover tests for HPLC pumps, autosampler, 
and various detector types. They are optimized for Thermo Scientific modules and are 
described in chapter 5, page Fehler! Textmarke nicht definiert.. For column thermostats 
or other chromatographic systems, the standard AutoQ tests are not available or 
optimized. In this case, the seqences and instrument methods have to be created 
manually according to chapter 5, page Fehler! Textmarke nicht definiert. or they have to 
be adapted accordingly. 

A wizard guides you through automated sequence creation. The sequences contain 
instrument methods that contains all necessary commands. The instrument methods are 
assigned automatically to the injections to process. 

The sequences are added automatically to the queue. The queue is started manually after 
the Ready Check has been performed. During injection processing, you can observe 
whether all functions are performed and the data acquired. The audit trail lists all 
instrument method commands including execution times, feedback from the injector, and 
name of the injection. After the sequence has been processed, the processed sinjections 
are evaluated highly automated with a report linked to the sequence templates. 

The qualification for a system with pump, autosampler and one detector takes about 
1.5 hours. 

For more information about the test design, see chapter 5, page Fehler! Textmarke nicht 
definiert.. 

4.2.2 Creating Sequence Templates 
 

1. From the Chromeleon 7 Console, select Tools > Instrument Qualification….  
A wizard guides you through the process of creating sequences.  

2. To go to the next step in the procedure, click Next>. 

3. Select the qualification type Installation Qualification. 

4. Select an instrument for which you want to conduct the communication test 
(Installation Qualification). 

5. Click OK. 
A number of test sequences is displayed, matching the instrument defined in this step 
and can contain the following sequences (maximum one per block): 
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Sequence / Order Necessary Device Property / Additional Requirement 

Block 1 

IQ_Pump(_xy) 

The IQ_Pump(_xy) sequence tests the flow rate for an analytical HPLC 
system. 

 IQ_Pump Pump.Flow and UV/Corona/MS detector 

 IQ_Pump_RI Pump.Flow and RI detector, but no UV/Corona/MS detector 

 IQ_Pump_FLD  Pump.Flow and FLD detector, but no UV/Corona/MS/RI detector 

 IQ_Pump_ECD Pump.Flow and ECD detector, but no UV/Corona/MS/RI/FLD detector 

Block 2 
IQ_Inject_Det(_xy) 

The IQ_Inject_Det(_xy) sequence tests the autosampler. Indirectly, this 
sequence also tests: 

• Corona detectors 

• MS detectors 

• RI detectors 

• Basic functions of Chromeleon 

 IQ_Inject_Det Inject and UV/Corona if the UV detector does not include a LightPipeTM flow 
cell, but no MS detector 

 IQ_Inject_Det_MS Inject and MS detector 

 IQ_Inject_Det_RI Inject and RI detector, but no UV/Corona/MS detector 

 IQ_Inject_Det_FLD Inject and FLD detector, but no UV/Corona/MS/RI detector 

 IQ_Inject_ECD Inject and ECD detector, but no UV/Corona/MS/RI/FLD detector 

Block 3  

IQ_Inject_Det_CAD Inject and Corona detector if the UV detector includes a LightPipe flow cell 

Block 4  

IQ_UV_Det This sequence tests a UV detector with variable wavelength. 

Wavelength <UV_VIS_1>(1) 

Block 5  

IQ_Inject_Det_RI Inject and RI and UV or Corona detector 

Block 6  

IQ_FL_Det This sequence tests a fluorescence detector. 

Emission wavelength <Emission_1>(1) 

Block 7  

IQ_EC_Det This sequence tests an electrochemical detector. 

Potential <ECDRS_1>(1) 

Block 8  

IQ_FC This sequence tests a fraction collector. 

(1) The device or channel name (marked by angle brackets <>) can be selected freely and may deviate from 
the default value. The created sequences and their instrument methods are adapted automatically to the 
used device and channel names. 
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6. Select the sequence(s) to be added. 

TIP For systems with a non-Chromeleon controlled detector, it is sufficient to run the test 
sequences IQ_Pump(_xy) and IQ_Inject_Det(_xy). 

 

7. Select a directory where all qualification sequences are to be created and stored 
(default directory: ChromeleonLocal/Instrument Data/<Instrument 
Name>/Qualification/IQ <dd mmm yyyy>). 

8. Click OK. 
All selected qualification sequences are automatically added to the instrument queue. 

4.2.3 Starting the Qualification Tests 
 

TIP The instrument method files included in the HPLC Templates folder do not provide any 
specific commands that may be required for control of third-party modules. If, for this 
reason, any warnings or error messages occur during instrument method execution, the 
templates have to be adapted accordingly. 

 

1. If necessary, modify the created sequences (see sections 7.1 and 3.3). 

TIP When an autosampler with variable injection volume is tested, the different volumes 
are not set in the injection list of the sequence. The instrument methods are different for 
each injection. They use the following command: 
0.000 Inject Volume=20 

 

2. To start the qualification sequences, click the Start button on the Queue tab of the 
ePanel. 
For troubleshooting deviating measuring conditions and results, refer to section 7.1, 
page 72. 
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4.2.4 Adapting the Report 

4.2.4.1 Report Structure 
The template consists of the following nine pages: 

Page Name Description 

General This page specifies the devices, test information (see section below) and 
limits. The limits are listed in column H, starting with line 23. You only have 
to change these limits if you do not want to use the limits recommended by 
Thermo Fisher Scientific Inc. 

Results_Pump These pages are used for the evaluation of the respective module.  

Remark: The result for the fraction collector has to be entered manually on 
Results_FC sheet. All other results are evaluated automatically. 

Results_Inj_Det 

Results_UV 

Results_FL 

Results EC 

Results MS 

Results_FC 

Audit Trail 

4.2.4.2 Adapting 
 

TIP The instrument parameters are read automatically only if the sequences have already 
been processed. If you open a report without samples, the values are not read 
automatically. 

Follow these steps 

1. Following cells should be unlocked by default. Otherwise, remove the protection of 
the General sheet via the Home ribbon and Protection group. 

2. On General sheet, enter: 
a) Batch numbers 

b) Expiration dates 

c) Names of reviewer and operator 

d) Enter the serial numbers of the instruments into lines O12-O20 (highlighted in 
light yellow):  
Typically, they are automatically entered into the report. If a serial number or 
model type field shows "n.a.": Delete the value in the respective field so that the 
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existing precond.xxx entry in the Status Line is deleted and enter the serial 
number into this field. 

e) Enter the model types of the instruments into lines L12-L20 (highlighted in light 
yellow):  
Typically, they are automatically entered into the report. If a model type field 
shows "n.a.": Delete the value in the respective field so that the existing 
precond.xxx entry in the Status Line is deleted and enter the model type into this 
field. 

TIP Notes regarding to the installation qualification can be documented on the individual 
module sheet of the report below the Notes section (field B78). If any remark is entered, 
remove the text No remarks. 

 

3. If applicable, enable the protection of the General sheet. 

4. If applicable, save the modifications and close the report. 

4.2.5 Report Evaluation 
 

TIP Before evaluating and signing the results, check that all peaks were detected properly. 
Otherwise, adapt the peak windows (within the processing method) accordingly. 

You can automatically evaluate the sequences, using the IQ_Report (Instruments_IQ_x_y) 
report template. If the measuring results are within the specified limits, the text in the 
Results of Instrument… section of the respective Results page is Test passed. There are 
two possibilities to evaluate and sign the report: 

• Paper based 

• Electronic signature 

TIP To be able to sign a test sequence electronically, the user has to be registered in the 
Chromeleon user database and has to have the necessary signature privileges. If, for 
example, a Field Service Engineer has to sign electronically, he has to be added to the 
Chromeleon user database or a registered substitute has to sign the report. For detailed 
information about the electronic signature process, see also the Chromeleon Help. 

Paper based 

In the Chromeleon 7 Console (Data category), click Print Report… on the context menu. 
By default, evaluation of the IQ_Pump and IQ_Inject_Det sequences is performed using 
the <UV_VIS_1> signal. If you want to evaluate a Corona detector, select the <CAD_1> 
channel in the Print dialog of the Print Report… function (see section 5.7.4, page 55). If 
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you want to evaluate an MS detector, select the <MS Quantitation> channel in the Print 
dialog of the Print Report… function (see section 5.10.4, page 61). For all other 
sequences, it is not necessary to adapt the channel name. 

Electronic signature 

1. Select the sequence that you want to evaluate and sign electronically. 

2. On the Sequence Control toolbar, click Submit. 

3. Select the channel to be used for evaluation: 

♦ UV detectors: <UV_VIS_1> 

♦ Corona detectors: <CAD_1> 

♦ MS detectors: <MS Quantitation> 

4. To create an electronic report, click Finish. 

5. Enter your signature password and optionally a comment. 

6. Click OK. 
The names and dates are automatically entered into the line Submitter / Operator. 

7. Optionally, repeat all steps above for Review Results… and / or Approve Results…. 
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5.1 Introduction 
This section describes the test design (basic measuring conditions, test procedure and the 
evaluation) for the different types of chromatography systems. The test design is 
implemented in the standard AutoQ checks and / or should be taken into account to 
perform the checks manually.  

The sections Basic Measuring Conditions list the basic chromatographic parameters and 
their set values. For all other parameters, accept the values suggested by the wizard 
which ensures that the program includes all program steps required for the connected 
modules and that the syntax is correct. With the given basic measuring conditions, the 
expected measuring results should be archieved. 

The test procedure lists the control parameters that are changed to test the functionality 
of the respective module. 
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5.2 Column Thermostats 
 

TIP This test is not covered by the standard AutoQ checks. Perform the test manually and 
document the results on the form IQ_Report_Comm_test.docx. 

5.2.1 Overview 

Only those column thermostats are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic function is checked: 

Setting the temperature 

5.2.2 Procedure 

1. Open a Chromeleon control panel. 

1. Set three different temperatures for the column thermostat that are distributed over 
the operating range of the module. 

2. If possible, verify the temperature settings on the thermostat display.  
The temperature parameters are logged in the audit trail.  

3. On the IQ_Report_Comm_Test form, document (e.g. via screenshots) that the test has 
been performed. 
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5.3 Pumps 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.3.1 Overview 

Only those pumps are checked that are controlled by Chromeleon via the corresponding 
device driver. The following basic functions are checked: 

• Setting the flow rate 

• Setting the pressure limits 

5.3.2 Setting the Flow Rate 

5.3.2.1 Procedure 

A sequence is created that contains three samples.  

If you use the templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_Pump(_xy) sequence, which contains the required 
samples.  

If the IQ_Pump(_xy) sequence is not offered or if you do not use the sequence templates, 
you have to create the sequence yourself.  

In both cases, the flow rate is varied as follows, based on the basic setting fB (analytical 
example: 0.6 mL/min). 

Portion of Basic Setting Flow Rate (Analytical Example) 

4/3 0.8 mL/min 

fB 0.6 mL/min 

2/3 0.4 mL/min 

5.3.2.2 Evaluation 

For all three samples, the retention time tr is evaluated for up to two peaks. The following 
three retention times will result: 
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• tr(1) for flow f1 = 2/3 x fB 

• tr(2) for flow f2 = fB 

• tr(3) for flow f3 = 4/3 x fB 

The following applies: 

rtVf /=  

)/1( fmtr =  
with: 

Parameter Description 

f Flow rate 

V Volume 

tr Retention time 

m Slope 

 

1. To calculate the slope m of this line, insert the three measured values in the two 
equations below: 

21

)2()1(
1 /1/1 ff

tt
m rr

−

−
=  

32

)3()2(
2 /1/1 ff

tt
m rr

−

−
=  

2. Compare the m1 and m2 values.  
With a working pump, the deviation between these values must not exceed ± 10%. 

3. If you use the flow rates mentioned above, use the equations below to calculate the 
slope m: 

)(2 )2()1(1 rrB ttfm −=  

)(4 )3()2(2 rrB ttfm −=  

Chromeleon evaluates the test based on the IQ_Report (see chapter 4, page 28).  

4. When performing the evaluation using a Corona or an MS detector, set the signal 
(<CAD_1> or <MS Quantitation>) in the Batch Report dialog window 
(see section 5.7.4, page 55 or section 5.10.4, page 61). 
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5.3.3 Setting the Pressure Limits 
 

1. On a Chromeleon control panel, set the pressure limits for the pump module. 

2. If possible, verify the selected limits on the pump display.  
The pressure limits are logged in the audit trail. 

3. Set the upper pressure limit to a value lower than the current system pressure. 

♦ Expectation 1: The pump is turned off automatically, and the corresponding action 
is logged in the audit trail. 

♦ Expectation 2: The pump flow is reduced automatically until the pressure is below 
the upper pressure limit. (Remark: The flow may be decreased to 0 mL/min if 
necessary). 

4. Check whether the pump fulfils the expectations: 

♦ All Thermo Scientific pumps: Expectation 1 must be fulfilled  

♦ All other pumps: Either expectation 1 or 2 has to be fulfilled (as specified by the 
corresponding manufacturer). 

5. On the IQ_Report_Comm_Test form, document that the test has been performed. 

5.4 Autosamplers 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.4.1 Autosamplers Controlled by Chromeleon 

5.4.1.1 Overview 

Only those autosamplers are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic functions are checked: 

• Selecting the sample position 

• Selecting the sample volume 

• Feedback on injection 
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5.4.1.2 Procedure 

Usually, the Chromeleon command used to select the sample position and the sample 
volume is a command combining the position and volume properties. 

If you use the templates shipped with Chromeleon (see chapter 4, page 28), the 
Instrument Qualification Wizard copies the IQ_Inject_Det(_xy) sequence, which contains 
the required samples.  

If the IQ_Inject_Det(_xy) sequence is not offered or if you do not use the sequence 
templates, you have to create the sequence yourself.  

In both cases, the injection volume is varied, based on the basic settings. 

Example for the variation of the injection volume (volumes may deviate depending on the 
autosampler to be qualified and the used detector type): 

Portion of Basic Setting Injection Volume (Analytical Example with UV Detector) 

Basic setting 10 µL 

1.5 times the basic setting 15 µL 

2 times the basic setting 20 µL 

5.4.1.3 Evaluation 
 

1. If possible, verify the sample position and volume settings on the autosampler display.  
The injection parameters are logged in the audit trail.  

2. Verify that the injection has been performed by checking the corresponding entry in 
the audit trail. 

3. Evaluate the peak area of up to two peaks for all three samples.  
♦ The peak areas and the injection volumes must be proportional to each other.  

♦ For a working autosampler, the deviations from the setpoint must not exceed 
± 5%. For qualification using a Corona or MS detector, the limit is ± 30%. 

Chromeleon evaluates the test based on the IQ_Report (see chapter 4, page 28). 

4. When performing the evaluation using a Corona detector, set the signal (<CAD_1>) in 
the Batch Report dialog window (see section 5.7.4, page 55 or section 5.10.4, 
page 61). 

5. On the IQ_Report_Comm_Test form, document that the test has been performed. 
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5.4.2 Autosamplers Not Controlled by Chromeleon 

5.4.2.1 Overview 

If your HPLC system contains a manual injection valve or a non-controlled autosampler, 
Chromeleon waits for the feedback from the injector after the injection command has 
been performed. The following basic function is checked: 

Injection feedback to Chromeleon 

5.4.2.2 Procedure 

A sequence is created that contains three samples and one program for all samples.  

If you use the templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_Inject_Det(_xy) sequence, which contains the 
required samples.  

If the IQ_Inject_Det(_xy) sequence is not offered or if you do not use the sequence 
templates, you have to create the sequence yourself.  

The injection volume is identical for the three samples. Chromeleon starts sample 
processing. When the system receives the injection command, Hold mode is enabled. The 
system performs the injection, cancels the Hold mode, and then starts data acquisition. 
After having processed the sample, Chromeleon automatically starts the next sample and 
processes it in the same way. 

5.4.2.3 Evaluation 
 

1. Verify that the injection has been performed by checking the corresponding entry in 
the audit trail. 

2. Evaluate the peak area of up to two peaks for each of the three samples.  
♦ For a working autosampler or injection valve, the peak area deviations of the 

three samples must not exceed ± 5%.  

♦ For qualification using a Corona or an MS detector, the limit is ± 30%. 

Chromeleon evaluates the test based on the IQ_Report (see chapter 4, page 28).  

3. When performing the evaluation using a Corona detector, set the signal (<CAD_1>) in 
the Batch Report dialog window (see section 5.7.4, page 55 or section 5.10.4, 
page 61). 

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 
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5.5 UV Detectors with Variable Wavelength 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.5.1 Overview 

Only those detectors are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic functions are checked: 

• Setting the wavelength 

• Autozero command 

5.5.2 Basic Measuring Conditions / Expected Measuring Results 

Use the following basic measuring conditions: 

Parameter Setting 

Eluent Water/methanol (60/40 Vol.%) 

Flow rate 0.600 mL/min 

Program run time 8 minutes 

Injection volume 10 µL 

Sample position Vanquish: R:A1 

UltiMate: RA1  

Any autosampler: 1 

Wavelength of the UV detector 272 nm 

Data collection rate for the UV signal UltiMate: 5 Hz 

Accela: 10 Hz 

Signal filter for the UV signal 1 s (ResponseTime – depends on the detector) 

Data acquisition rate for the Corona signal 10 Hz 

Column thermostat temperature (optional) 25 °C 

Expected measuring results 

The measuring conditions return a signal with two peaks for the UV detector. The peak 
height should be between 50 and 600 mAU. 

If necessary, adapt the range settings or other signal-relevant parameters. 
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5.5.3 Setting the Wavelength 

5.5.3.1 Procedure 

A sequence is created that contains two samples. 

If you use the templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_UV_Det sequence, which contains the required 
samples. 

If the IQ_UV_Det sequence is not offered or if you do not use the sequence templates, you 
have to create the sequence yourself.  

In both cases, the wavelength is varied as follows, based on the basic settings: 

Parameter Setting 

Wavelength 1 (basic) 272 nm 

Wavelength 2 290 nm 

If you use a substance other than caffeine, adapt the settings accordingly. Select two 
wavelengths for which you expect clearly distinct signal heights. 

5.5.3.2 Evaluation 

Signal evaluation depends on the standard used: 

• If caffeine has been used, the signal height of the caffeine peak is evaluated for both 
samples. The signal height ratio is as follows: 

)290(
)272(

nmHeightSignal
nmHeightSignalRatio =

 

For a working detector, the ratio must be between 1.5 and 10.0. Chromeleon 
evaluates the test based on the IQ_Report (see chapter 4, page 28). 

• If a substance other than caffeine has been used, it is only possible to perform 
qualitative signal evaluation.  

Follow these steps 

1. If possible, verify the wavelength setting on the detector display. 
The wavelength parameters are logged in the audit trail. 

2. On the IQ_Report_Comm_Test form, document that the test has been performed. 
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5.5.4 Autozero Command 

1. Execute injection from a Chromeleon control panel. 

2. Select the Autozero command on the control panel while a substance elutes. 

3. On the Chromeleon signal plot, verify that the signal changes as expected. 

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 

 

5.6 FL Detectors 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.6.1 Overview 

Only those FL detectors are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic functions are checked: 

• Setting the excitation and emission wavelength 

• Autozero command 

5.6.2 Basic Measuring Conditions / Expected Measuring Results 

Use the following basic measuring conditions: 

Parameter Setting 

Eluent 100% methanol 

Flow rate 0.600 mL/min 

Program run time 8 minutes 

Injection volume 10 µL 

Sample position Vanquish: R:A2 

UltiMate: RA2 

Any autosampler: 2 

Excitation wavelength 335 nm 

Emission wavelength 390 nm 
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Parameter Setting 

Data acquisition rate for the 
signal 

5 Hz 

Step for the fluorescence 
signal 

0.2 s 

Column thermostat 
temperature (optional) 

25 °C 

Expected measuring results – Summit RF Series 

The conditions return a signal with one peak (pyrene) for the FL detector of the Summit 
RF series for which the peak height should be between 50 and 700 mV. 

If necessary, adapt the range settings or other signal-relevant parameters. 

Expected measuring results – UltiMate and Vanquish Series  

For the FL detector of the UltiMate and Vanquish series, you receive a signal with one 
peak (pyrene) with an expected peak height between 2 million and 30 million counts. 

If necessary, adapt the range settings or other signal-relevant parameters. 

5.6.3 Setting the Excitation and Emission Wavelength 

5.6.3.1 Procedure 

For verification of the two parameters, a sequence with four samples is created.  

If your system includes an FL detector and a UV and/or a Corona detector, you will be 
asked during processing of sample 1 to change the eluent and to flush the system with 
methanol. Follow the instructions provided by Chromeleon. 

If your system includes only an FL or RI detector, this step is skipped automatically. 

If you use the sequence templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_FL_Det sequence, which contains the required 
samples.  

The excitation (λEx) and emission (λEm) wavelength is varied as follows, based on the 
basic settings: 

• Sample 1: Change eluent, if necessary [water / methanol (60/40 Vol. %) to methanol 
(100 Vol. %)] 

• Sample 2 (basic setting): λEx = 335 nm / λEm = 390 nm 
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• Sample 3 (variance (λEx): λEx = 350 nm / λEm = 390 nm 

• Sample 4 (variance (λEm): λEx = 335 nm / λEm = 430 nm 

If the IQ_FL_Det sequence is not offered or if you do not use the sequence templates, you 
have to create the sequence yourself. For the excitation (λEx) and emission (λEm) 
wavelength variations, see above. 

If a substance other than pyrene has been used, you may have to adapt the settings 
accordingly. Select two excitation and emission wavelengths for which you expect clearly 
distinct signal heights. 

5.6.3.2 Evaluation 

Signal evaluation depends on the standard used: 

• If pyrene was used, the signal height of the pyrene peak will be evaluated for all 
samples. The signal height ratio [Ratio(λEx) or Ratio(λEm)] is as follows: 

)nm 390 =  / nm 350 = (
)nm 390 =  / nm 335 = ()(

Ex

Ex
Ex

Em

Em

heightSignal
heightSignalRatio

λλ
λλ

λ =

 

)nm 430 =  / nm 335 = (
)nm 390 =  / nm 335 = ()(

Ex

Ex
Em

Em

Em

heightSignal
heightSignalRatio

λλ
λλ

λ =
 

For a working detector, both ratios must be larger than 3. Chromeleon evaluates the 
test based on the IQ_Report (see chapter 4, page 28). 

• If a substance other than pyrene has been used, it is only possible to perform 
qualitative signal evaluation. 

Follow these steps 

1. If possible, verify the excitation and emission wavelength setting on the detector 
display. 
The wavelength parameters are logged in the audit trail.  

2. On the IQ_Report_Comm_Test form, document that the test has been performed. 

5.6.4 Autozero Command 

1. Execute injection from a Chromeleon control panel. 

2. Select the Autozero command on the control panel while a substance elutes. 

3. On the Chromeleon signal plot, verify that the signal changes as expected. 

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 
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5.7 Corona Detectors 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.7.1 Overview 

Only those Corona detectors are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic functions are checked: 

Change of the peak area depending on the substance concentration. 

TIP A system that includes only a Corona detector as detector device can also be used to 
qualify a pump (see section 5.3, page 44) or autosampler (see section 5.4, page 46). 

5.7.2 Basic Measuring Conditions / Expected Measuring Results 

Use the measuring conditions listed in section 5.5, page 49. 

Expected measuring results 

For the Corona detector you will also receive a signal with two peaks. Only the second 
peak (caffeine), however, will be evaluated. The height of the second peak should be 
between 1 and 50 pA. 

5.7.3 Procedure 

The sequence IQ_Inject_Det is used for evaluation of a Corona detector with one 
exception: If the HPLC system includes a Vanquish VH-D10-A UV detector with a 
LightPipe™ flow cell, the sequence IQ_Inject_Det_CAD is used. 

If you use the sequence templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_Inject_Det(_CAD) sequence, which contains the 
required samples.  

If the IQ_Inject_Det(_CAD) sequence is not offered or if you do not use the sequence 
templates, you have to create the sequence yourself. 
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5.7.4 Evaluation 

Perform the evaluation as described in section 5.4.1.3, page 47. 

NOTICE Only the caffeine peak is used for evaluation. If you use the sequence 
IQ_Inject_Det and you perform the evaluation using the Batch Report… file command, 
make sure that the Corona detector channel (default channel name: <CAD_1>) is selected 
in the Batch Report dialog window in the With selected channel box. If the sequence 
IQ_Inject_Det_CAD is used, the last step is not necessary. 

 

5.8 Electrochemical Detectors 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.8.1 Overview 

Only those electrochemical detectors are checked that are controlled by Chromeleon via 
the corresponding device driver. In direct current mode, the following basic functions are 
checked: 

• Setting the potential (using channel 1) 

• Functional test of channel 2 (if available) 

• Autozero command 

5.8.2 Basic Measuring Conditions / Expected Measuring Results 

Use the following basic measuring conditions to check the coulometric cells (6011RS, 
6020RS) and amperometric cells (6041RS) with glassy carbon working (GC) or boron-
doped diamond (BDD) electrode: 

Parameter Setting 

Eluent 100% TEST mobile phase 

Flow rate 0.600 mL/min 

Program run time 12 minutes 

Injection volume 10 µL 
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Parameter Setting 

Vial position Vanquish: R:A3 

UltiMate: RA3 

Any autosampler: 3 

Potential channel 1   

 Coulometric cells (6011RS, 6020RS) and 
amperometric cells (6041RS) with glassy 
carbon working (GC) electrode 

+400 mV 

 Amperometric cells (6041RS) with boron-
doped diamond (BDD) working electrode 

+800 mV 

Potential channel 2 (if available) +400 mV 

Data acquisition rate 10 Hz 

Filter constant 5 sec 

Gain range (optional) 500 nA 

Column thermostat temperature (optional) 35 °C 

When qualifying electrochemical cells that have two channels (for example, coulometric 
cell 6011RS for UltiMate 3000 ECD-3000RS), check both channels. To do so, perform the 
test described in section 5.8.3, page 57. 

NOTICE After changing the cell conditions (potential), equilibrate the cell at least for 
5 minutes. 

Expected measuring results – EC Detector with Coulometric Cell (6011RS, 6020RS) 

The basic measuring conditions return a signal with three peaks (norepinephrine, 
epinephrine and dopamine) for which the peak heights should be between 30 and 500 nA.  

Only applicable for the 6011RS cell: When testing channel 1, the peaks are typically seen 
on channel 1 and not channel 2. When testing channel 2, the peaks are typically seen on 
channel 2 and not on channel 1. 

If necessary, adapt the range settings or other signal-relevant parameters. 

Expected measuring results – EC Detector with Amperometric Cell (6041RS) 

Independent of the used working electrode, the basic measuring conditions return a 
signal with three peaks (norepinephrine, epinephrine and dopamine) for which the peak 
heights should be between 0.5 and 30 nA. 

If necessary, adapt the range settings or other signal-relevant parameters. 
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5.8.3 Setting the Potential / Functional Test 

5.8.3.1 Procedure 

A sequence with two samples is created for this test.  

If you are using the template sequences shipped with Chromeleon (see chapter 4, 
page 28), the Instruments_IQ Wizard creates a copy of the sequence IQ_EC_Det, which 
includes the required samples.  

If the sequence IQ_EC_Det is not offered or if you are not using the templates, you must 
create the sequence by yourself.  

In both cases, the potential is varied as follows, starting with the basic setting: 

Cell Potential 1 (Basic Setting) Potential 2 

Coulometric cell (6011RS, 6020RS) / 
amperometric cell (6041RS) with GC 
electrode 

  

 channel 1 400 mV -175 mV 

 channel 2, if available 400 mV 400 mV 

Amperometric cell (6041RS) with BDD 
electrode 

800 mV -175 mV 

If you are using a different standard than the catecholamine standard for this test, you 
may have to adapt the settings. In this case, select two potentials where you expect a 
noticeable difference regarding signal areas. 

5.8.3.2 Evaluation 

Signal evaluation depends on the standard used: 

• If the catecholamine standard was used, the signal areas of the three peaks are 
evaluated for both samples. The signal area ratio is calculated for all three peaks. 
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Channel Number Formula 

1 

)2(
)1(

1_ PotentialareaSignal
PotentialareaSignalRatio ChannelMin =  

2 

)1_2(
)2_2(

2_ ChannelPotentialareaSignal
ChannelPotentialareaSignalRatio ChannelMin =  

The smallest ratio of each channel must be greater than 10 for a fully functional 
detector. The test is evaluated in Chromeleon with the IQ_Report created for this test 
(see chapter 4, page 28). 

• If a different standard than the catecholamine standard is used, the signals can only 
be evaluated qualitatively.  

Follow these steps 

1. Check the detector display, if applicable, to find out whether the selected potential is 
set correctly.  
The Audit Trail logs the detection parameters.  

2. Use the IQ_Report_Comm_Test.docx form to document this test. 

5.8.4 Autozero command 

1. Execute injection from a Chromeleon control panel. 

2. Select the Autozero command on the control panel while a substance elutes. 

3. On the Chromeleon signal plot, verify that the signal changes as expected. 

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 

 

5.9 RI Detectors 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.9.1 Overview 

Only those RI detectors are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic function is checked:  
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Peak area change depending on the substance concentration. 

5.9.2 Basic Measuring Conditions / Expected Measuring Results 

Use the following basic measuring conditions: 

Parameter Setting 

Eluent 100% methanol 

Flow rate 0.600 mL/min 

Program run time 8 minutes 

Injection volume 10 µL 

RI detector temperature 35 °C 

Polarity Plus 

Baseline shift 0 

Data collection rate 5 Hz 

Rise time 2 s 

Column thermostat 
temperature (optional) 

35 °C 

 

Expected measuring results 

These conditions return a signal with one peak (toluene) for the RI detector for which the 
peak height should be between 50 and 500 µRIU. 

If necessary, adapt the range settings or other signal-relevant parameters. 

5.9.3 Procedure 

For checking an RI detector, the sequence IQ_Inject_Det_RI is used. In contrast to the 
sequence IQ_Inject_Det, the sequence IQ_Inject_Det_RI contains two additional samples 
to change the eluent and to rinse the RI detector. 

If your system contains an RI and an UV and/or Corona detector, you will be prompted to 
change the eluent and to switch to methanol during sample 1. Follow the instructions in 
Chromeleon. 

If your system only contains an RI detector, the mentioned step and rinsing the RI detector 
will be skipped.  
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If the sequence templates provided by Chromeleon are used (see chapter 4, page 28), the 
Instruments_IQ Wizard creates a copy of this sequence that contains all necessary 
samples.  

If the sequence IQ_Inject_Det_RI is not offered or if the sequence templates are not used, 
you have to create the sequence yourself. 

5.9.4 Evaluation 

Perform the evaluation as described in section 5.4.1.3, page 47. 

5.10 MS Detectors 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

 

Notice Acceptable results can only be obtained if the detector is properly calibrated 
before (positive and negative polarity). Before starting the installation qualification, verify 
that the MS detector is ready for operation according to the instrument operating 
manual. 

5.10.1 Overview 

Only the following basic function of Vanquish MS detectors is checked: 

Peak area depending on the polarity and mass. 

TIP A system that includes only an MS detector as detector device can also be used to 
qualify a pump (see section 5.3, page 44) or an autosampler (see section 5.4, page 46). 

5.10.2 Basic Measuring Conditions / Expected Measuring Results 

Use the measuring conditions listed in section 5.5, page 49. In addition, use the following 
MS settings: 

Parameter Setting 

Source HESI 

Source settings Easy, default settings depend on the set flow rate 
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Parameter Setting 

Method type Basic 

Scans  

 Uracil  

  Mass 111.0 amu 

  Polarity Negative 

  Source CID voltage 20 eV 

 Caffeine  

  Mass 195.1 amu 

  Polarity Positive 

  Source CID voltage 20 eV 

Acquisition rate  

 Min. baseline peak width 3.0 s 

 Desired scans per peak 6 

Expected measuring results 

For the MS detector, you will receive a signal with two peaks. The area of the first peak 
(uracil) should be above 500 counts*min and the area of the second peak (caffeine) 
should be above 20000 counts*min (injection volume: 6 µL). 

5.10.3 Procedure 

The sequence IQ_Inject_Det_MS is used for evaluation of an MS detector. 

If you use the sequence templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_Inject_Det_MS sequence, which contains the 
required samples. 

If the IQ_Inject_Det_MS sequence is not offered or if you do not use the sequence 
templates, you have to create the sequence yourself. 

The polarity and the mass are varied, as described in the MS scan settings (see 
section 5.10.2, page 60). 

5.10.4 Evaluation 

Perform the evaluation as described in section 5.4.1.3, page 47. 
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5.11 ELS and other Detectors 
 

TIP ELS and other detectors are not covered by the standard AutoQ checks. Perform the 
test manually and document the results on the form IQ_Report_Comm_test.docx. 

5.11.1 Overview 

Only those detectors are checked that are controlled by Chromeleon via the 
corresponding device driver.  

If the detector is the only module of the HPLC system, follow the steps described in 
section 5.4.2, page 48 to check the basic functions of Chromeleon (see section 2.1, 
page 12). 

5.11.2 Basic Measuring Conditions / Expected Measuring Results 

Use the following basic measuring conditions for an ELS detector: 

Parameter Setting 

Eluent 100% water 

Flow rate 0.500 mL/min 

Program run time 3 minutes 

Injection volume 20 µL 

Nebulizer temperature 50 °C 

Evaporator temperature 90 °C 

Gas flow rate 1.6 SLM at 4.1 bar 

Step for the ELS signal 0.2 seconds 

Expected measuring results – ELS detector 

These conditions return a signal with one peak (glucose) for the ELS detector for which 
the signal height should be between 500 and 1000 mV*s. 

If necessary, adapt the range settings or other signal-relevant parameters. 

5.11.3 Procedure 

1. Open a Chromeleon control panel. 

2. Set a control parameter for the detector module. 
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Typical control parameter influencing the signal is the evaporator temperature (for 
evaporative light scattering detectors). 

3. If possible, verify the selected parameter setting on the detector display.  
The parameters are logged in the audit trail.  

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 

 

5.12 Fraction Collectors 
 

TIP These tests and their documentation on the form IQ_Report_Comm_test.docx can be 
omitted when the automatic instrument installation qualification is performed - see also 
section 1.1.2, page 8. 

5.12.1 Overview 

Only those fraction collectors are checked that are controlled by Chromeleon via the 
corresponding device driver. The following basic function is checked: 

Time controlled solvent collection in a 1.5 mL standard vial. 

5.12.2 Basic Measuring Conditions / Expected Measuring Results 

Use the following basic measuring conditions: 
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Parameter Setting 

Eluent 100% solvent A (as already used, e.g., water/methanol (60/40 Vol.%) or 
100% methanol) 

Flow rate 0.600 mL/min 

Program run time 1 minute 

Injection type Blank 

Fraction collection Collect by time (Collection period: 60 s; start time: 0.1 min, end time: 0.9 
min) 

Collection time frame Start time: 0.1 min, end time: 0.9 min, flush: No 

Thermostat temperature Off 

Wash mode NoWash 

Rinse mode NoRinse 

Collect path mode Horizontal 

Needle positioning mode InVial 

 

Expected measuring results 

These conditions return a vial (R:A1) filled with collected solvent for which the volume 
should be between 0.1 and 0.9 mL. Document the result in the IQ report on sheet 
Results_FC – results table. 

TIP If available, the volume can also be measured with a precision pipette (1 mL). The 
expected volume should be between 0.4 and 0.6 mL (the limits can be adapted on the 
General page of the report – see chapter 4.2.4.1, page 38). 

 

If necessary, adapt relevant parameters. 

5.12.3 Procedure 

For checking a fraction collector, the sequence IQ_FC is used. 

If the sequence templates provided by Chromeleon are used (see chapter 4, page 28), the 
Instruments_IQ Wizard creates a copy of this sequence that contains all necessary 
samples.  

If the sequence IQ_FC is not offered or if the sequence templates are not used, you have to 
create the sequence yourself. 
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6.1 Checking all Systems 
 

TIP Dependent on the system, these tests are not necessarily covered by the standard 
AutoQ checks. If the Chromeleon does not offer any sequence templates, perform the 
test manually and document the results on the form IQ_Report_Comm_test.docx. 

The separation conditions for GC applications largely depend on the used columns. The 
user must make the appropriate test mixture and the separation method available. Make 
sure that the application fulfills the conditions described in section 3.4, page 27. 

NOTE The used columns and detectors influence the operating range of the GC systems. 
That is why the user must provide information about the operating range. Adapt the 
parameters as necessary. 

6.1.1 Procedure 

In each test run, as many modules as possible are tested. This is to optimize the test effort 
for GC systems.  

1. Create a sequence that contains three samples for each combination to be tested.  

2. Create a program and an evaluation method that are both used for all three samples. 

3. Create a separate sequence for each detector that is controlled by Chromeleon. 

4. Create a separate sequence for each of the configured inlet valves (see also 
section 6.4, page 67). 

5. Open a Chromeleon control panel and set some parameters on the GC.  

6. If possible, verify the settings on the display of the GC module. 

6.1.2 Evaluation 
 

1. Evaluate the peak area of up to two peaks for each of the three samples.  
The peak area deviations of the three samples must not exceed ± 5%. Chromeleon 
evaluates the test based on the IQ_Report (see chapter 4, page 28). 

2. On the IQ_Report_Comm_Test form, document that the test has been performed. 
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6.2 GC Column Thermostats 
Only those column thermostats are checked that are controlled by Chromeleon via the 
respective driver. 

1. In addition to the check described in section 6.1, page 66, set three different 
temperature values for the column thermostat (observe the operating temperature 
range of the column used). 

2. If possible, verify the selected temperatures on the display of the GC.  
The temperature parameters are logged in the audit trail.  

3. Check each column thermostat of the GC system. 

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 

6.3 GC Detectors 
Only those GC detectors are checked that are controlled by Chromeleon via the respective 
driver.  

1. In addition to the check described in section 6.1, page 66, open a control panel and 
set three different temperature values for the detector heating.  

2. If possible, verify the selected temperatures on the display of the GC.  
The temperature parameters are logged in the audit trail.  

3. Check each detector of the GC system. 

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 

6.4 Temperature Settings on the Sample Inlet Valve 
To check the temperature settings: 

1. Open a control panel. 

2. Set three different temperature values for the sample inlet valve. 

3. If possible, verify the selected temperature settings on the display of the GC.  
The temperature parameters are logged in the audit trail.  

4. Check each sample inlet valve of the GC system. 

5. On the IQ_Report_Comm_Test form, document that the test has been performed. 



6   •   GC Systems 

HPLC Instrument Installation Qualification Revision: 5.7 dated July 2022  Page 68 

6.5 GC Sample Injection 
For all injection types, the feedback on injection is checked. This manual distinguishes 
between controlled autosamplers (see section 6.5.1, page 68) and non-controlled (see 
section 6.5.2, page 69) autosamplers. 

6.5.1 Controlled GC Autosamplers 

6.5.1.1 Overview 

Only those GC autosamplers are checked that are controlled by Chromeleon via the 
respective device driver. The following basic functions are checked: 

• Selecting the sample position 

• Selecting the sample volume 

• Feedback on injection 

6.5.1.2 Procedure 

Usually, the Chromeleon command to select the sample position and the sample volume 
is a command combining the position and volume properties. A sequence is created that 
contains three samples.  

If you use the templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_Inject_Det sequence, which contains the required 
samples. 

If you do not use the sequence templates, you have to create the sequence yourself.  

In both cases, the injection volume is varied as follows, based on the basic settings 
(see section 6.1, page 66): 

• Basic setting (Example: 1 µL) 

• 2 times the basic setting (Example: 2 µL) 

• 4 times the basic setting (Example: 4 µL) 

The three samples are injected from different positions. 
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6.5.1.3 Evaluation 
 

1. If possible, verify the sample position and volume settings on the autosampler display. 
The injection parameters are logged in the audit trail.  

2. Verify that the injection has been made by verifying the corresponding entry in the 
audit trail. 

3. Evaluate the peak area of up to two peaks for all three samples. 

♦ The peak areas and injection volumes must be proportional to each other.  

♦ With a working autosampler, the deviations from the setpoint must not exceed 
± 5%. 

Chromeleon evaluates the test based on the IQ_Report (see chapter 4, page 28)  

4. On the IQ_Report_Comm_Test form, document that the test has been performed. 

6.5.2 Non-Controlled Autosamplers 

6.5.2.1 Overview  

If your GC system contains a manual injection valve or a non-controlled autosampler, 
Chromeleon waits for the feedback from the injector after the injection command has 
been performed. The following basic function is checked: 

Injection feedback to Chromeleon 
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6.5.2.2 Procedure 

A sequence is created that contains three samples and one program for all samples. 

If you use the templates shipped with Chromeleon (see chapter 4, page 28), the 
Instruments_IQ Wizard copies the IQ_Inject_Det sequence, which contains the required 
samples.  

If the IQ_Inject_Det sequence is not offered or if you do not use the sequence templates, 
you have to create the sequence yourself.  

The injection volume is identical for the three samples. Chromeleon starts sample 
processing. When the system receives the injection command, Hold mode is enabled. The 
system performs the injection, cancels the Hold mode, and then starts data acquisition. 
After having processed the sample, Chromeleon automatically starts the next sample and 
processes it in the same way. 

6.5.2.3 Evaluation 
1. Verify that the injection has been performed by checking the corresponding entry in 

the audit trail.  

2. Evaluate the peak area of up to two peaks for each of the three samples.  
For a working autosampler, the peak area deviations of the three samples must not 
exceed ± 5%.  

Chromeleon evaluates the test based on the IQ_Report (see chapter 4, page 28).  
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7.1 Troubleshooting 
The table below contains tips for deviating measuring conditions and results. 

Problem Cause Remedial Action 

Peak flattening and/or different 
injection volumes 

Using a higher injection volume 
may result in that you leave the 
linear range of the detector or 
overload the column. As a result, 
the peak flattens. 

Dilute the used standard by the 
factor by which the injection 
volume was increased. 

Another reason for peak 
flattening may be an unfavorable 
ratio between the absorption 
path length and the flow cell 
volume. 

Increase the flow rate. 

Peaks are too low or too high The signal parameters of 
detectors whose signals are 
transmitted to Chromeleon as 
analog signals very often 
determine the gain factor at the 
module's analog output. 

Optimize these parameters if the 
signals are too low or too high. 
Verify that the gain factor is set 
correctly in the Server Configuration 
program.  

If the signals are too high, you may 
as well dilute the used standard. 

If you still do not achieve the signal 
heights described above, refer to 
the tips for preparative HPLC 
systems in section 3.3, page 26. 

Peaks do not appear or bad 
separation 

Large dead volumes in the 
system may result in that the two 
substances do not elute during 
the runtime of the program. 

Composition of eluent 
Water/methanol (60/40 Vol.%) is 
not correct. 

Extend the runtime. A runtime of 
20 minutes should be sufficient for 
the two peaks to appear. 

If the signals still do not appear, 
replace the column by a capillary 
coupling. This is to exclude the 
column as source of trouble. 
Besides, refer to the tips in the table 
cell above when the signals are too 
low. 

Check and / or exchange the eluent. 
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7.2 IQ_Report_Comm_Test_x_y.docx form 
For a filled-in IQ_Report_Comm_Test_5.7.docx form (with an example of an Agilent 
instrument), see the attached pages below. 

A template is available as electronic document. 

TIP On the first page, enter the instrument details, test case(s) and test result(s). On the 
attachment sheet, enter the sceenshots. 

 

 





Installation Qualification: Communication Test Report  
 

IQ_REPORT_COMM_TEST_5.7.docx Revision: 5.7  July 2022  
Reproduction is forbidden without consent - Violation will be prosecuted 

Installation Qualification: Communication Test Report 
Description of the Tested System 

Name of CM Server: CSFKST 
Name of Timebase: HP 1100 

Installed Instruments: 

Name of Instrument: Supplier: Model: Serial Number: 

Pump Agilent G1312A (Binary Pump) 123456 

Sampler Agilent G1313A 123456 

ColumnThermostat Agilent G1316A  123456 

UV Agilent G1314A VWL 123456 

                        

                        

                        

                        
 
Test Description 

Tested Instrument: Pump 
Tested Functionality: Pressure Limits 

Test Case: System pressure 50 bar. Set upper pressure limit to 40 bar. 

Test Result: 
 
 
 
 

 

New settings are logged in the Audit Trail. Pump stopped flow. 
 
Audittrail: 
[] 13:28:30 Log Pressure.Value: 51.2 
[] 13:28:36 Pressure.UpperLimit = 40.0 
[Abort] 13:28:36 {Pump} System pressure above upper limit 

X Test Passed  Test Failed X Attachment(s) 
 

 

Service Engineer  2013-02-20  Customer 

Operator  Date of Performance  Reviewer 
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Installation Qualification: Communication Test Report - Attachment 
Description of Tested System  

Name of CM Server: CSFKST 
Name of Timebase: HP 1100 

Tested Instrument: Pump 

Tested Functionality: Pressure Limits 
 
 

 
 

 
 
 
 

 

Service Engineer  2013-02-20  Customer 

Operator  Date of Performance  Reviewer 
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